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To the Instructor 
 

I. Introduction to Computer Technology 3101 
 

Computer Technology 3101 is the first of two courses designed to give the adult learner with 

limited or no experience using a personal computer the skills necessary to use computers in their 

everyday life.  In this course, students will become familiar with and comfortable working within 

the Windows environment.  They will learn how to use the keyboard using the touch method and 

they will learn how to use e-mail effectively.  Students will learn the basics of word processing 

and produce several documents using word processing software.  Finally, they will learn how to 

use the Internet efficiently, while remaining cognizant of possible threats while online.  A 

student-centered approach to instruction with reliance upon instructor guidance and facilitation is 

recommended for this course.   

 

In Unit 1, Introduction to Windows, students will become familiar with the Windows desktop 

and the mouse.  They will work with multiple applications and close windows.  Students will 

learn how to use Windows Explorer and work with files and folders.  They will create a copy 

using “Save As”, learn how to create shortcuts, and access and organize folders on the desktop.  

Students will use different search options for finding files and folders in Windows Explorer. 

 

In Unit 3, Keyboarding and E-mail, students will learn to key the alphabetic keys by touch and 

with good technique.  They will become familiar with the parts of an e-mail program such as 

Microsoft Outlook, create an E-mail message, and attach a file and send an e-mail message.  

They will reply to and forward an e-mail message, manage their e-mail, work with the address 

book, and adjust e-mail settings. 

 

In Unit 3, Introduction to Word, students will explore the features of a word processing program 

such as Microsoft Word, open and save a document, format and edit a document, use the 

thesaurus and check spelling and grammar, and preview and print a document.  They will format 

text, use the format painter, change page orientation and text alignment, create bulleted and 

numbered lists, and insert a picture in a document. 

 

In Unit 4, Using the Internet, students will learn about the World Wide Web, how computers 

connect to the Internet, and online safety.  They will use a Web browser to navigate the Internet, 

and practice using their Favorites and History lists.  Students will learn effective ways to search 

the Internet for specific information, as well as evaluate the quality of information on a Web site.   

 

Students are required to complete six Assignments and maintain both a hard and electronic 

Portfolio in this course.  However, there are many topics included in the text and teacher’s guide 

that students may be interested in exploring further.  Students may be given additional 

assignments or the opportunity to investigate topics as group work.  Coordination with the 

English, Math, and Science programs is possible in assigning and evaluating additional work.   
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To the Instructor 
 

II. Curriculum Guide 
 

Each new ABE Computer Technology course has a Curriculum Guide for the instructor and a 

Study Guide for the student.  The Curriculum Guide includes the specific curriculum outcomes 

for the course.  Suggestions for teaching, learning, and assessment are provided to support 

student achievement of the outcomes.  Each course is divided into units.  Each unit comprises a 

two-page layout of four columns as illustrated in the figure below.  In some cases the four-

column spread continues to the next two-page layout. 

 
Curriculum Guide Organization: 

The Two-Page, Four-Column Spread 
 

Unit Number - Unit Title  Unit Number - Unit Title 

 

Outcomes 
 

Specific 

curriculum 

outcomes 

for the unit. 

Notes for Teaching and Learning 
 

Suggested activities, elaboration of 

outcomes, and background 

information. 

 Suggestions for Assessment 
 

Suggestions for assessing 

students’ achievement of 

outcomes.  

 

Resources 
 

Authorized and 

recommended 

resources that 

address 

outcomes. 

 

III. Study Guides 
 

The Study Guide provides the student with the name of the text(s) required for the course and 

specifies the sections and pages that the student will need to refer to in order to complete the 

required work for the course.  It guides the student through the course by assigning relevant 

reading and providing questions and/or assigning questions from the text or some other resource.  

Sometimes it also provides important points for students to note.  (See the To the Student section 

of the Study Guide for a more detailed explanation of the use of the Study Guides.)  The Study 

Guides are designed to give students some degree of independence in their work.  Instructors 

should note, however, that there is much material in the Curriculum Guides in the Notes for 

Teaching and Learning and Suggestions for Assessment columns that is not included in the Study 

Guide and instructors will need to review this information and decide how to include it. 
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To the Instructor 
 

IV. Resources 
 

Essential Resources 

 

Haag, S.E.  (2009).  Computer Concepts in Action.  New York: McGraw Hill.  

ISBN 0-07-880577-5  

 

Haag, S.E.  (2009).  Computer Concepts in Action Teacher Resource Manual.  

New York: McGraw Hill.  ISBN 0-07-880725-5 

 

Van Huss, S.H., Forde, C.M., Woo, D.L., and Hill, J.  (2009).  College 

Keyboarding: Keyboarding Course, Lessons 1-25, Seventeenth 

Canadian Edition.  Scarborough: Nelson Education Ltd.  ISBN 978-0-17-

644060-2 

 

Van Huss, S.H., Forde, C.M., Woo, D.L., and Robertson, J.  (2008).  Keyboarding 

Pro Deluxe.  [CD-ROM].  Scarborough: Nelson Education Ltd.  

 ISBN 0-17-647455-2 

 

Recommended Resources 

 

n.a.  (2005).  Computer Concepts in Action ExamView Pro Test Generator [CD-

ROM].  McGraw-Hill.  ISBN 0-07-872875-4 

 

n.a.  (2005).  Glencoe TechSim Interactive Tutorials [CD-ROM].  McGraw-Hill.  

ISBN 0-07-872877-0 

 

Pray, J. P.  (2003).  MC1050: Introduction to Computers.  New York: Element 

K. 
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To the Instructor 
 

V. Recommended Evaluation 
 

Written Notes  10% 

Portfolio   30% 

Assignments   30% 

Test(s)    10% 

Final Exam    20% 

      100% 
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Unit 1 – Introduction to Windows 
 

Outcomes 
 

1.1 Turn on and log on to a 

computer. 

 

1.1.1 Log on to a computer 

using a user name and 

password. 

 

 

 

 

 

 

 

 

 

1.2 Demonstrate proficient use of 

the mouse. 

 

1.2.1 Locate the left button, 

scroll wheel, and right button 

on a mouse. 

 

1.2.2 Recognize and 

describe the function of 

common mouse pointers, 

including the arrow pointer, 

hand, I-beam, two-headed 

arrow, and four-headed 

arrow. 

 

1.2.3 Demonstrate an 

understanding of common 

mouse commands, including 

click, double-click, right-

click, and drag. 

 

Notes for Teaching and Learning 
 

Prior to beginning the course, instructors should ensure 

students are assigned a username and password so that they 

can log on to school computers.  Some students may have 

very little experience with computers so it is important to 

provide specific direction with regards to turning on and 

accessing Windows. 

 

The student edition of Computer Concepts in Action (2009) 

has been written to work with Microsoft Office 2007 and 

Windows Vista.  All of the screen captures in the text were 

created with Microsoft Office 2007.  If an older version of 

Windows or Office is being used, it is recommended that 

the previous text edition, Computer Concepts in Action 

(2006) be used instead.   

 

This section is covered in the text after an introduction to 

the desktop.  However, in order for the student to explore 

the desktop, he or she must be familiar with the use of the 

mouse.  Thus, in the study guide students will learn about 

the mouse first before exploring the desktop. 

 

Some students may want to use the mouse with their left 

hand.  Settings may be reversed for a left-handed user.  

Appendix C-5 of the student textbook provides details on 

how to accomplish this. 

 

Instructors may need to help students who have trouble 

moving the mouse arrow around the screen.  Using a laser 

pointer or a pencil, instructors could point to a spot on an 

individual screen, then have the student move the mouse 

arrow to meet it.   

 

Instructors should remind students to click on the left 

mouse button to launch a program.  A right-click will cause 

a menu with other options to appear. 
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Unit 1 – Introduction to Windows 
 

Suggestions for Assessment 
 
A major component of the evaluation for Computer 
Technology 3101 is a portfolio.  Students will maintain 
both a physical and electronic portfolio where they will 
keep samples of their work.  Instructors should periodically 
assess the student’s portfolio to ensure the student is 
successfully completing all required work and to remediate 
any problems the student may be having. 
 
This course will greatly benefit students with little or no 
computer experience.  Due to this lack of experience, 
however, students may initially demonstrate some 
trepidation when using a computer for the first time.  
Instructors should provide ample support to students and 
formatively assess their progress on a regular basis.  This 
will prevent initial problems from escalating and increase 
student’s confidence levels. 
 
Instructors could have students click the Start button to 
access the Start menu, and then have them write down all 
of the commands of tools available from the menu.  They 
could include a short description of the function of each 
command or tool.  Instructors should discuss any Start 
menu options that students do not understand. 
 
Students could complete questions 13 – 25 in the Unit 1 “e-
Quizzes–Pre-Quizzes” quiz found under the Unit 1 
Resources tab on the Glencoe Online Learning Center 
website.  This would help the student identify areas where 
he or she has some previous knowledge and areas that are 
not as familiar.   
 
Instructors could assign “Tech Talk Activity 1.1: History of 
Computers” as an optional assignment.  This activity is 
found under the Unit 1 Resources tab on the Glencoe 
Online Learning Center website. 
 
Students could complete “Enrichment Activity 1.1: 
Technology in Your Life” and place a copy of the 
completed “Protecting Your Computer” checklist in their 
portfolio.  This activity is found under the Unit 1 Resources 
tab on the Glencoe Learning Center website. 
 

Resources 
 
Computer Concepts in Action, 
Unit 1 Project 2, pages 19 – 36. 
 
Computer Concepts in Action 
Teacher Resource Manual, Unit 1 
Project 2, pages 112 – 117. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Glencoe Online Learning Center, 
http://glencoe.com 
 
 
 
 
 
Glencoe Online Learning Center, 
http://glencoe.com 
 
 
 
Glencoe Online Learning Center, 
http://glencoe.com 
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Unit 1 – Introduction to Windows 

 

Outcomes 
 

1.2.4 Practice using the 

mouse to open and close 

programs, drag items, and 

resize windows. 

 

1.3 Describe elements of the 

Windows desktop. 

 

1.3.1 Describe the layout 

and function of the desktop. 

 

1.3.2 Define icon and give 

examples. 

 

1.3.3 Identify the following 

items on the desktop: Start 

button, recycle bin, My 

Computer, Time/Date, 

taskbar, and other icons. 

 

1.3.4 Locate the following 

items in the Start menu: All 

Programs, Log Off, Shut 

Down, and the version of 

Windows. 

 

1.4 Demonstrate an 

understanding of how the 

Windows environment functions. 

 

1.4.1 Differentiate between 

a program and an application. 

 

1.4.2 Define window. 

 

1.4.3 Locate and describe 

the taskbar. 

 

 

 

Notes for Teaching and Learning 
 

 

 

 

 

 

On the desktop, instructors could have students identify the 

items that they will work with when they use Windows.  

Windows desktop screens will vary depending on the 

operating system installed and the network setup.  

Instructors should remind students that their screens might 

not look exactly the same as the screen captures that appear 

in the student textbook. 

 

Instructors should remind students not to keep clicking the 

mouse button or press the Enter key multiple times, as it 

will not affect how quickly the computer responds, and 

might actually cause problems. 

 

 

 

 

 

 

 

 

 

Instructors could start a class discussion about the different 

versions of Microsoft Windows (95, 98, 2000/ME, XP, 

Vista).  Instructors should explain that Microsoft releases 

new versions and upgrades of their operating system to 

keep up with user needs and demands, new security and 

virus threats, and technological innovations.  Further 

information about these versions can be found at the 

Microsoft Web site. 
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Unit 1 – Introduction to Windows 

 

Suggestions for Assessment 
 

Students could also complete “Enrichment Activity 1.2: 
Technology in Your Life” and place a copy of the 
completed “Protecting Your Computer Part 2” checklist in 
their portfolio.  This activity is found under the Unit 1 
Resources tab on the Glencoe Learning Center website. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resources 
 
Glencoe Online Learning Center, 
http://glencoe.com 
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Unit 1 – Introduction to Windows 

 

Outcomes 
 

1.4.4 Make a window 

smaller and larger using the 

Minimize, Restore Down, 

and Maximize buttons. 

 

1.4.5 Move between two 

open applications. 

 

1.4.6 Demonstrate how to 

close Windows using either 

Log off, Shut down, Restart, 

or Standby. 

 

 

 

 

 

 

 

 

 

1.5 Categorize types of 

computers based on their size, 

power, and purpose. 

 

1.5.1 Differentiate between 

a personal computer, 

minicomputer, and 

mainframe computer. 

 

1.6 Describe types of 

microcomputers. 

 

1.6.1 Compare and contrast 

PCs and Macs. 

 

1.7 Explain how a computer 

processes information. 

 

1.7.1 Describe the role of 

the central processing unit. 

Notes for Teaching and Learning 
 

When students use the Restore Down button, their screens 

may end up looking smaller than the one shown in the 

figure.  Instructors should assure them that this is normal, 

as Restore Down sizes differ from computer to computer.  

Instructors should also explain that the Restore Down and 

Maximize buttons replace each other, depending on the 

current state of the window. 

 

The figures in the textbook may not look like the Shut 

Down box on students’ computers.  Some versions of 

Windows say “Turn off computer” rather than “Shut 

down”.  Also, some computers may have a Hibernate 

option rather than Stand By. 

 

Instructors should explain to the class the difference 

between Log On/Log Off and Turn On/Shut Down.  Log 

On/Log Off is used to access or close out of a particular 

network or settings configuration while leaving the 

computer on, whereas Turn On/Shut Down is used to 

actually turn the computer itself on and off. 
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Unit 1 – Introduction to Windows 

 

Suggestions for Assessment 
 

Unit 1 Project 2 Assessment Answers are found in the 

Computer Concepts in Action Teacher Resource Manual. 

 

 

 

 

 

 

Students could complete questions 3, 5, 12, and 14 – 24 in 

the Unit 1 “e-Review quiz” found under the Unit 1 

Resources tab on the Glencoe Online Learning center to 

test their comprehension of the outcomes covered to this 

point. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Students could complete questions 2 – 21 in the Unit 2 “e-
Quizzes–Pre-Quizzes” quiz found under the Unit 2 
Resources tab on the Glencoe Online Learning Center 
website.  This would help the student identify areas where 
he or she has some previous knowledge and areas that are 
not as familiar.   

 

 

 

 

 

 

 

 

Resources 
 

Computer Concepts in Action 

Teacher Resource Manual, page 

115. 

 

 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

 

 

 

 

 

 

 

 

Computer Concepts in Action, 

Unit 2 Tech Talk, pages 40 – 50. 

 

Computer Concepts in Action 

Teacher Resource Manual, Unit 2 

Tech Talk, pages 127 – 132. 

 

Glencoe Online Learning Center, 

http://glencoe.com 
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Unit 1 – Introduction to Windows 

 

Outcomes 
 

1.7.2 Explain how the speed 

of the microprocessor is 

measured. 

 

1.7.3 Differentiate between 

a bit and a byte. 

 

1.8 Discuss the function of 

computer hardware components. 

 

1.8.1 Describe the types and 

purposes of external 

computer components, 

including standard input and 

output devices. 

 

1.8.2 Describe the types and 

purposes of internal computer 

components. 

 

1.8.3 Describe the types and 

purposes of storage media 

(e.g. DVDs and network 

drives). 

 

1.8.4 Identify ports used to 

connect input and output 

devices to a computer (e.g. 

USB ports and Ethernet 

ports). 

 

1.8.5 Explain how hardware 

devices are installed on a 

computer system. 

 

1.9 Describe how computers 

store data. 

 

1.9.1 Differentiate between 

RAM and ROM. 

Notes for Teaching and Learning 
 

 

 

 

 

 

 

 

Instructors could have students identify and connect 

various hardware components to demonstrate their 

understanding of computer components. 
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Unit 1 – Introduction to Windows 

 

Suggestions for Assessment 
 

 

 

 

 

Instructors could assign “Tech Talk Activity 2.1, Bits and 

Bytes”, as an optional assignment.  This activity is found 

under the Unit 2 Resources tab on the Glencoe Online 

Learning Center website. 

 

Students can complete Worksheet 2A: “Identify Hardware 

Basics” as review and reinforcement of computer 

hardware.  Students can place the completed worksheet in 

their portfolio. 

 

 

Instructors could assign “Tech Talk Activity 2.5, Input and 

Output Devices”, as an optional assignment.  This activity 

is found under the Unit 2 Resources tab on the Glencoe 

Online Learning Center website. 

 

Students can complete Worksheet 1B: “Is it Input or 

Output?” as review and reinforcement of input and output 

devices.  Students can place the completed worksheet in 

their portfolio. 

 

 

 

 

 

 

 

 

 

 

 

Instructors could assign “Tech Talk Activity 2.2, Storage”, 

as an optional assignment.  This activity is found under the 

Unit 2 Resources tab on the Glencoe Online Learning 

Center website. 

 

Resources 
 

 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

Computer Concepts in Action 

Teacher Resource Manual, page 

357.  Also found on the Glencoe 

Online Learning Center, 

http://glencoe.com 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

Computer Concepts in Action 

Teacher Resource Manual, page 

355.  Also found on the Glencoe 

Online Learning Center, 

http://glencoe.com 

 

 

 

 

 

 

 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 
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Unit 1 – Introduction to Windows 

 

Outcomes 
 

1.9.2 Describe the function 

of storage devices, and give 

examples. 

 

1.10 Explain how software and 

hardware work together to perform 

computing tasks. 

 

1.10.1 Define software. 

 

1.10.2 Distinguish between 

operating system software, 

application software, and 

utility software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.11 Describe the purpose of an 

operating system. 

 

1.11.1 Identify different 

operating systems including 

DOS, Windows and 

Macintosh. 

 

1.11.2 Describe the 

capabilities and limitations 

imposed by the operating 

system. 

 

 

Notes for Teaching and Learning 
 

 

 

 

 

Students should be aware of the software on their 

computers and how these programs are installed.  

Instructors could have students open the Start menu and 

note the programs listed.  Students could identify installed 

applications and their functions by looking at the icons and 

software names. 

 

Instructors should explain to students that applications like 

Microsoft Office, computer games, and other types of 

software can be bought at a store and installed by inserting 

the manufacturer’s CD into the computer.  Software such as 

upgrades, freeware like RealPlayer and QuickTime, and 

many other applications and games can be downloaded 

directly to a computer from the Internet. 

 

If possible, instructors could bring in an installation CD for 

a software application.  Instructors could insert the CD into 

a computer to demonstrate how Windows automatically 

starts installing the new application.  Instructors should 

explain the legal agreement and go over each step in the 

installation wizard.  After installation is complete, restart 

the computer, if necessary, and demonstrate how to find 

and start the application from the Start menu.  
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Unit 1 – Introduction to Windows 

 

Suggestions for Assessment 
 

 

 

 

 

Instructors could assign “Tech Talk Activity 2.3, Software”, 

as an optional assignment.  This activity is found under the 

Unit 2 Resources tab on the Glencoe Online Learning 

Center website.   

 

 

 

 

Answers to Tech Talk Captions and Activities are found in 

the Teacher Resource Manual. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resources 
 

 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

 

 

 

Computer Concepts in Action 

Teacher Resource Manual, page 

128 – 131. 
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Unit 1 – Introduction to Windows 
 

Outcomes 
 

1.12 Manage files using the 

Windows Explorer/File Manager. 

 

1.12.1 Describe the function 

of a file manager program. 

 

1.12.2 Differentiate between 

a drive, folder, and file. 

 

1.12.3 Practice organizing 

files using Windows 

Explorer. 

 

1.12.4 Change the way 

folders and files are 

displayed. 

 

1.12.5 Display the file or 

folder’s size, type and date 

modified. 

Notes for Teaching and Learning 
 

Instructors could start the topic of file management by 

discussing why and how organization is used in day-to-day 

life.  Instructors could explain that goods and information 

are organized so that they are easy to manage, understand, 

and find.  For example, city planners organize streets, 

grocery stores organize food, books and newspapers 

organize information, and businesses organize files. 

 

Instructors should show students where on the network they 

can access and save the files they will work on throughout 

the course.  A shortcut could be placed on the desktop so 

that students can easily access the folder. 

 

Instructors could discuss the importance of backing up files 

onto a separate drive to prevent information loss.  

Instructors could discuss instances where students, or their 

friends or family members, had put in a lot of time on the 

computer to complete a school paper, project, or work 

presentation only to have it lost or destroyed at the last 

minute.  Students could be asked what steps could have 

been taken to prevent or retrieve the lost effort.  Students 

should also be aware that some companies require 

employees to back up computers every day or week.  

Another way to back up files is to e-mail the information to 

another workstation or print it for permanent filing. 

 

Instructors should reinforce that it is the student’s 

responsibility to take the proper precautions to back up and 

preserve his or her work. 

 

Instructors should show students alternate ways to open 

Windows Explorer.  It can be opened by right-clicking the 

Start button, then selecting Explore.  Alternatively, it can 

be opened by clicking My Computer on the desktop, then 

clicking the Folders button on the toolbar. 
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Unit 1 – Introduction to Windows 
 

Suggestions for Assessment 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Resources 
 

Computer Concepts in Action, 

Unit 2 Project 1, pages 51 – 68. 

 

Computer Concepts in Action 

Teacher Resource Manual, Unit 2 

Project 1, pages 133 – 139. 
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Unit 1 – Introduction to Windows 
 

Outcomes 
 

1.12.6 Create a new folder 

using Windows Explorer. 

 

1.12.7 Copy a folder and 

paste it into another folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.12.8 Move a file by 

copying and pasting it. 

 

 

 

 

 

 

1.12.9 Rename a file using a 

proper file extension. 

 

1.12.10 Delete a file. 

 

 

 

 

 

 

 

 

 

Notes for Teaching and Learning 
 

To make it easier to find documents, students should use 

descriptive file names.  The complete path to the file, 

including the drive letter, server name, folder path, and file 

name and extension can contain up to 255 characters.  

Instructors should explain that file names cannot include 

any of the following characters: forward slash (/), backslash 

(\), greater-than sign (>), less-than sign (<), asterisk (*), 

question mark (?), quotation mark (“), pipe symbol (|), 

colon (:), or semicolon (;). 

 

Students should identify the school network’s storage areas 

as they appear on the Windows Explorer organization 

chart.  These should include the desktop, local disk drive 

(traditionally the C: drive), 3½” floppy disk drive (A:), and 

CD drive (D:).  The school’s network may also include a 

DVD drive, external drive, or an additional hard drive 

where the school’s server is located. 

 

Instructors should remind students that if they delete a 

file/folder from a network location, it might not be moved 

to the Recycle Bin, and therefore may be permanently 

deleted.  Additionally, files that are saved on a network that 

is password protected may be difficult to share if students 

work on a team project with someone who does not have 

access. 

 

Instructors should explain to students that the file name 

extension (a period followed by three or four letters or 

numbers) is used to associate a file with the program or 

application needed to open it.  For example, “.DOC” 

associates a file with Word, “.XLS” indicates an Excel 

spreadsheet.  If students try to open an Excel document 

from Word, it will either not open or the formatting will be 

lost.  Instructors should provide a list of the types of media 

and the file formats in which they are stored.  (These 

include .BMP, .GIF, and .JPG for graphics; .WAV and 

.MP3 for audio; and .MOV and QuickTime for video and 

animation.) 
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Unit 1 – Introduction to Windows 

 

Suggestions for Assessment 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resources 
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Unit 1 – Introduction to Windows 
 

Outcomes 
 

1.12.11 Explain how and 

when to use the Save As 

command. 

 

1.12.12 Create a copy of a 

file using the Save As 

function. 

 

1.13 Manipulate desktop folders 

and icons. 

 

1.13.1 Define shortcut. 

 

 

1.13.2 Create, rename, and 

move files on the desktop. 

 

 

 

 

1.14 Locate missing files, folders 

and applications. 

 

1.14.1 Use Windows Search 

methods to locate missing 

files, folders and 

applications. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notes for Teaching and Learning 
 

Instructors should let students create their own folders in a 

designated location.  This will be the location they will 

save their work to during the course.  Students should use 

their first and last names in the folder name. 

 

 

 

 

Many computer labs are designed to be “frozen”, so that 

any changes students make to the desktop will not be 

saved.  If the lab is not “frozen”, students should undo their 

changes before the end of class so the desktop is returned to 

normal for next class. 

 

Instructors should emphasize tips that students can use 

when manipulating and managing files.  For instance, they 

should regularly back up important files in case of 

computer system failure, or delete unnecessary files to save 

disk space and avoid confusion and clutter. 

 

Windows will look for variations in spelling, capital use 
(caps), and abbreviations in a search name or word.  
Instructors should demonstrate for students how different 
spellings of files might change the search results. 
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Unit 1 – Introduction to Windows 
 

Suggestions for Assessment 
 

Unit 2 Project 1 Assessment Answers are found in the 

Computer Concepts in Action Teacher Resource Manual. 

 

 

Students could complete questions 1 – 19 in the Unit 2 “e-

Review quiz” found under the Unit 2 Resources tab on the 

Glencoe Online Learning center to test their comprehension 

of the outcomes covered to this point. 

 

Instructors could use the ExamView Test Generator 

software along with the test bank of questions for this unit 

to create tests for students.  Instructors can customize the 

test to suit the needs of the class or add additional 

questions.  Instructors should review the test questions and 

choose the questions and formats that suit the level of the 

students. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resources 
 

Computer Concepts in Action 

Teacher Resource Manual, pages 

136 – 137. 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

CD-ROM: Glencoe Computer 

Concepts in Action, ExamView 

Pro Test Generator. 
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Unit 2 – Keyboarding and E-mail 
 

Outcomes 
 

2.1 Key the alphabetic keys on a 

standard QWERTY keyboard by 

touch. 

 

2.1.1 Key straight copy with 

good accuracy. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2 Explain how electronic mail 

works. 

 

2.2.1 Identify the 

components of an electronic 

mail message. 

 

2.2.2 Identify different 

electronic mail options and 

explain when they would be 

used. 

 

2.3 Demonstrate the proficient 

use of an electronic mail 

application. 

Notes for Teaching and Learning 
 

Students will need to create a profile the first time they use 

Keyboarding Pro.  Instructors may need to guide students 

through this process. 

 

The text for this unit, College Keyboarding: Keyboarding 

Course, Lessons 1-25, Canadian 17
th

 Edition, and the 

accompanying CD-ROM, Keyboarding Pro Deluxe, are 

designed for use with Microsoft Office 2007 and Windows 

Vista.  If an older version of Windows is being used, the 

16
th

 edition of the text should be used, as should the CD-

ROM Keyboarding Pro 3.2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Some students may already have experience using e-mail, 

but instructors should emphasize that the exercises in this 

unit will teach them skills that they might never have 

thought about, such as attaching files, managing e-mail 

messages, and adjusting e-mail settings. 
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Unit 2 – Keyboarding and E-mail 
 

Suggestions for Assessment 
 

Students are required to place a printed copy of the Lesson 

Report from lessons 1 – 10 in Keyboarding Pro Deluxe in 

their portfolio.  While there is no minimum gwam required, 

students are encouraged to strive for at least 25 gwam. 

 

 

Students are required to complete lessons 11 – 13 and 

submit the Lesson Reports as an assignment.  Students are 

not required to obtain a minimum gwam in order to pass 

the assignment.  However, instructors should directly 

observe the student’s typing to ensure the student is using 

the correct technique. 

 

Instructors can provide students with Worksheet 1C, 

Keyboard Keys, found under the Unit 1 Resources tab on 

the Glencoe Online Learning Center website.   

 

Instructors should tell students that they can take timings 

more than once and try to increase their speed with each 

timing.  They should be encouraged to push themselves just 

a little past their comfort zone in each practice to improve 

their speed.  Students should also be aware that accuracy is 

as important as speed, and that keeping their eyes on their 

copy will minimize the number of errors they make when 

they type. 

 

 

 

 

 

 

 

 

 

 

 

Answers to the Assessment questions on page 481 of the 

text can be found in the Teacher Resource Manual. 

 

 

Resources 
 

College Keyboarding, lessons 1 – 

13, pages 1 – 30. 

 

Keyboarding Pro Deluxe [CD-

ROM], lessons 1 – 13. 

 

Computer Concepts in Action, 

Appendix A: Keyboarding, pages 

420 – 466. 

 

 

 

 

Computer Concepts in Action 

Teacher Resource Manual, 

Teaching Tips for Keyboarding, 

Appendix A: pages 339 – 341.  

Also found on the Glencoe Online 

Learning Center, 

http://glencoe.com 

 

 

 

 

 

Computer Concepts in Action, 

Appendix B: E-mail, pages 467 – 

482. 

 

Computer Concepts in Action 

Teacher Resource Manual, 

Teaching Tips and 

Troubleshooting Tips for 

Appendix B: E-mail, pages 342 – 

345. 

 

Computer Concepts in Action 

Teacher Resource Manual, 

Appendix B Assessment Answers, 

page 345. 



 

______________________________________________________________________________ 

Curriculum Guide Page 19/44 Computer Technology 3101 

 

Unit 2 – Keyboarding and E-mail 
 

Outcomes 
 

2.3.1 Create and send 

electronic mail messages. 

 

2.3.2 Illustrate ways to 

supplement a mail message 

with additional information. 

 

 

 

 

 

2.3.3 Manage e-mail 

attachments. 

 

 

 

 

 

 

 

2.3.4 Reply to an e-mail 

message. 

 

 

 

 

 

 

 

 

 

 

2.3.5 Forward an e-mail 

message. 

 

 

 

 

 

Notes for Teaching and Learning 
 

Instructors should discuss with students the different e-mail 

programs they might use.  Many people use programs that 

are available for free through Internet portals.  For 

example, Hotmail is offered by MSN.com, and Yahoo also 

offers e-mail accounts.  These accounts can be accessed 

from any computer that is connected to the World Wide 

Web.  Another popular program is Outlook Express, which 

is available for free to Microsoft Windows users.  This 

software can be downloaded to one computer and connects 

to the user’s Internet Service Provider.   

 

Instructors should explain to students that large attachments 

can sometimes cause problems for the receiver.  If the 

receiver has a slow connection (like a dial-up modem), a 

large attachment such as a movie can take a very long time 

to download and can tie up the receiver’s e-mail.  Also, free 

e-mail accounts such as Hotmail or Yahoo often have a 

limited mailbox size.  An e-mail may not be deliverable if 

the attachment is too large or if the mailbox is full. 

 

Instructors should discuss what happens when e-mail goes 

back and forth between senders and nobody deletes the 

previous messages.  Eventually, the e-mail string becomes 

very long.  And if more than one person is involved, 

everyone can read the previous messages (which is not 

always a good idea).  Instructors can ask students for 

examples of when it would be best to delete the original 

message, when it would be better to keep it, and ways to 

keep only parts of the message (e.g. cutting and pasting, or 

inserting a reply into the original message using a different 

color). 

 

Instructors should explain to students that when they 

forward a message with an attachment, the attachment will 

remain in the forwarded e-mail.  If they want to send only 

the message without the attachment, they must clear the 

attachment first.  To do so, they would right click the 

attachment and choose Clear from the drop-down menu. 
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Unit 2 – Keyboarding and E-mail 
 

Suggestions for Assessment 
 
Students are required to complete the “Step-by-Step” 
exercise on pages 481 – 482 of the text and submit it to the 
instructor as an assignment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Resources 
 

Computer Concepts in Action, 

Step-by-Step, pages 481 – 482. 
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Unit 2 – Keyboarding and E-mail 
 

Outcomes 
 

2.3.6 Manage e-mail. 

 

 

 

 

 

 

 

 

2.3.7 Create contacts and 

manage e-mail addresses. 

 

 

 

 

 

 

 

 

 

 

2.3.8 Customize e-mail 

settings. 

 

Notes for Teaching and Learning 
 

Instructors should explain to students that if they receive a 

lot of e-mail, it can be very difficult to find important 

messages unless they keep their messages organized.  

Effective file management helps organize information so 

that it can be found easily and quickly.  Instructors should 

encourage students to use previously learned file 

management skills to create and organize folders for their 

e-mail messages. 

 

Instructors could show students the different ways to 

automatically add a contact name to the “To:” line in an e-

mail message.  They can: 

 open the address book, click on a name, and then 

click the New Message to Contact button on the 

toolbar; 

 open a contact card and click the New Message to 

Contact button; or 

 open a new e-mail message, click the To: button, 

then click one of the names in the contact list that 

pops up. 

 

Instructors could demonstrate to students how they can add 

names to a Blocked Senders list in Outlook.  Click the 

Tools menu, then choose Options.  On the Preferences tab, 

click Junk E-mail, then click the Blocked Senders tab.  

Click Add, and enter the e-mail message in the Inbox.  On 

the shortcut menu, click Junk E-mail, then Add Sender to 

Blocked Senders List. 
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Unit 2 – Keyboarding and E-mail 
 

Suggestions for Assessment 
 

Instructors could use the ExamView Test Generator 

software along with the test bank of questions for this unit 

to create tests for students.  Instructors can customize the 

test to suit the needs of the class or add additional 

questions.  Instructors should review the test questions and 

choose the questions and formats that suit the level of the 

students. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Resources 
 
CD-ROM: Glencoe Computer 
Concepts in Action, ExamView 
Pro Test Generator. 
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Unit 3 – Introduction to Word Processing 

 

Outcomes 
 

3.1 Recognize and describe 

common features of word 

processing software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.1.1 Find and identify 

features including Menus, 

Standard Toolbar, Formatting 

Toolbar, New Document 

Task Pane, Taskbar, Scroll 

Bars, and Text Area. 

 

 

Notes for Teaching and Learning 
 

While many types of word processing software are in use 

today, it is assumed that the majority of students will have 

access to a version of Microsoft Word, as it is the most 

commonly used program that is commercially available.  

As such, the Curriculum Outcomes and Notes for Teaching 

and Learning were created with this in mind.  However, it 

is entirely possible to achieve the Curriculum Outcomes 

using a different program such as Corel WordPerfect.  

Instructors should note that the text refers exclusively to 

Microsoft Word 2007.  

 

Prior to beginning this unit, instructors should discuss with 

students the importance of effective writing as an essential 

element of communication, whether it is by hand or using 

word processing software.  In order to successfully 

communicate, students must have the tools to write clearly, 

concisely, and coherently.  Instructors could have students 

write down why strong writing skills are necessary in 

society and discuss student responses in class. 

 

Instructors could ask students why word processing is 

necessary to be a successful lifelong learner.  Instructors 

could discuss why academic or professional documents 

must be clear, concise, focused, and correctly formatted, 

and what types of documents should use word processing 

(e.g. stories, research papers, legal documents). 

 

Instructors should explain to students the difference 

between the Exit, Close, and Close Window commands.  

The two buttons at the top right corner of the Word window 

are Close (the Red Close button exits the Word program) 

and Close Window (the blue, or orange, button closes the 

active document).  From the File Menu, select exit to exit 

the Word Program and Close to close the active document. 
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Unit 3 – Introduction to Word Processing 

 

Suggestions for Assessment 
 
 
 
 
 
 
 
 
Students could complete questions 6 – 25 in the Unit 4 “e-
Quizzes–Pre-Quizzes” quiz found under the Unit 4 
Resources tab on the Glencoe Online Learning Center 
website.  This would help the student identify areas where 
he or she has some previous knowledge and areas that are 
not as familiar.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Students could complete Worksheet 4C: “Microsoft Word 
Ribbon”, as review and reinforcement of standard and 
formatting toolbars.  Students can place the completed 
worksheet in their portfolio. 
 
 
 
 
 
 
 
 
 
 

Resources 
 
Computer Concepts in Action, 
Unit 4 Project 1, pages 134 – 151. 
 
Computer Concepts in Action 
Teacher Resource Manual, Unit 4 
Project 1, pages 186 – 191. 
 
Glencoe Online Learning Center, 
http://glencoe.com 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Computer Concepts in Action 
Teacher Resource Manual, page 
365.  Also found on the Glencoe 
Online Learning Center, 
http://glencoe.com 
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Unit 3 – Introduction to Word Processing 

 

Outcomes 
 

3.1.2 Demonstrate how the 

same tasks can be completed 

using toolbar buttons, menus, 

and/or keyboard shortcuts. 

 

 

3.2 Create and save a Word 

document. 

 

3.2.1 Open a new Word 

document. 

 

3.2.2 Create a Word 

document. 

 

3.2.3 Use the Save and Save 

As command to save a 

document. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3 Perform common editing and 

formatting functions using word 

processing software. 

Notes for Teaching and Learning 
 

In addition to the Standard and Formatting toolbars, 

instructors should demonstrate other toolbars for students.  

Click the View menu and select Toolbars, then choose a 

toolbar to view.  Students could practice viewing and 

moving toolbars to different parts of the Word window. 

 

 

 

 

When Word is opened, a new blank document should 

appear on the screen.  If not, students should be instructed 

to either click the New Blank Document button on the 

toolbar or click the File menu and select New. 

 

 

Instructors should review with students how to save 

documents effectively.  Instructors should remind students 

to immediately name and save the document they are 

formatting.  Students should be shown how to find the 

folder where they save their work.  Instructors should 

explain that it is a good idea to create file names that are 

easy to remember, save different drafts of documents, and 

group files into well-named folders.  (Note: When students 

see Your Name in their textbooks, they should type in their 

own name or follow the file naming system the instructor 

has provided them to use.) 

 

As students work with documents, they should save their 

work every few minutes.  Before the end of class, 

instructors should remind students to save their work and 

close the application. 

 

The Communications instructor could review the format of 

a professional business letter with the students.  Language 

Arts or Business textbooks can be used to reinforce how to 

format and write business letters, or Appendix B of the 

student textbook may be useful. 
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Unit 3 – Introduction to Word Processing 

 

Suggestions for Assessment 
 

 

 

 

 

 

 

Students could complete “Enrichment Activity 4.1: Use 

Templates in Word” and save a copy of the edited 

document in their electronic portfolio.  This activity is 

found under the Unit 4 Resources tab on the Glencoe 

Learning Center website. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resources 
 

 

 

 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 
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Unit 3 – Introduction to Word Processing 

 

Outcomes 
 

3.3.1 Cut, copy and paste 

text. 

 

 

 

 

 

 

3.3.2 Use the thesaurus and 

the Spelling and Grammar 

tool to edit a document. 

 

 

 

 

 

 

 

 

3.3.3 Use the Print Layout 

view, the Zoom tool, and 

Print Preview to view a 

document. 

 

3.3.4 Use the Page Setup 

options to manipulate a 

document. 

 

3.4 Perform simple text 

formatting. 

 

3.4.1 Differentiate between 

format and font. 

 

 

 

 

 

Notes for Teaching and Learning 
 

If students type new text and the existing text seems to be 

“disappearing”, instructors should have students check to 

see if the OVR button is illuminated on the Status bar at the 

bottom of the Word window.  If so, they can double-click 

the OVR button or press the Insert key on the keyboard to 

turn off the Overtype setting.  (The Insert key toggles the 

overset text option on/off.) 

 

Microsoft Word can be set to call out words that are not in 

the default Word dictionary (look for the squiggly red line 

under text).  Instructors should explain to students that 

proper names and uncommon words are not included in the 

Word dictionary, but can be added during the Spell Check 

process.  Instructors should show students how to use the 

Add button in the Spelling and Grammar dialog box. 

 

Instructors should have dictionaries available in the 

classroom to assist in spelling. 

 

If the student cannot see the entire letter on the monitor, the 

Zoom box can be adjusted to 75% or 100%.  By default, 

many screens are set at 150%. 

 

 

 

 

 

 

As students work through the steps of each exercise they 

should note when a figure is mentioned.  They should 

compare their own work to the figure at that point.  If their 

screen looks very different from the figure, then they 

should check their work and repeat the steps if needed.  

Note that if a different version of Word than the one shown 

in the textbook is used, the students’ screens may look 

different from the ones shown. 
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Unit 3 – Introduction to Word Processing 

 

Suggestions for Assessment 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Students could also complete “Enrichment Activity 4.2: 
Print an Envelope” and place the envelope in their 
portfolio.  This activity is found under the Unit 4 Resources 
tab on the Glencoe Learning Center website. 
 
Students are required to complete the “Step-by-Step” 
exercise on pages 146 – 148 of the text and place a copy of 
the letter in their portfolio. 
 
Answers to “Project 1 Assessment” questions on page 149 
of the text can be found in the Teacher Resource Manual. 
 
 
Students are required to complete the “Step-by-Step” 
exercise on pages 149 – 150 and submit the letter to the 
instructor as an assignment. 
 
 
 
 
 
 
 
 
 
 
 
 

Resources 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Glencoe Online Learning Center, 
http://glencoe.com 
 
 
 
Computer Concepts in Action, 
pages 146 – 148. 
 
 
Computer Concepts in Action 
Teacher Resource Manual, Project 
1 Assessment Answers, page 189. 
 
Computer Concepts in Action, 
pages 149 – 150. 
 
 
 
Computer Concepts in Action, 
Unit 4 Project 2, pages 152 – 166. 
 
Computer Concepts in Action 
Teacher Resource Manual, Unit 4 
Project 2, pages 192 – 197. 
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Unit 3 – Introduction to Word Processing 

 

Outcomes 
 

3.4.2 Format the size, color, 

and style of selected text in a 

document. 

 

 

 

 

 

 

3.4.3 Use the Format Painter 

to copy formatting. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.5 Modify page orientation and 

text alignment in a document. 

 

3.5.1 Define orientation. 

 

3.5.2 Differentiate between 

portrait and landscape 

orientation. 

 

3.5.3 Define alignment. 

 

3.5.4 Describe the text 

alignment options that are 

available. 

Notes for Teaching and Learning 
 

If students choose a light color for their text, instructors 

should alert them that a black and white printer may not 

show the text visibly. 

 

Students can click on the Font box and scroll down to see 

all of the available font styles.  They can also click on the 

Font Size box and scroll down to see the available font 

sizes. 

 

If the default setting places the Standard and Formatting 

toolbars on one line, it can be hard to see all the toolbar 

commands.  Instructors can demonstrate how to move the 

Formatting Toolbar down to reveal more toolbar buttons.  

To move any toolbar, have students click the top or right 

side of the toolbar (the four headed arrow appears) and drag 

the toolbar down one line.  Once a toolbar has an entire line 

to itself, students will find a more complete array of 

command buttons on each toolbar, including the Format 

Painter button. 

 

Instructors could have students move the mouse pointer 

slowly over the Format Painter button, without clicking.  

The name of the button will appear.  Instructors could then 

explain that this is a helpful way to identify any of the 

Word command buttons. 

 

When students change the alignment, the entire text may  

not be visible.  Instructors should remind students to click 

the Zoom box to change the magnification to 75% or 100% 

in order to view the entire page of text. 

 

In the Page Setup window, instructors could have students 

choose the Paper tab.  On a separate sheet of paper, the 

students could list all the different sizes of paper that 

Microsoft Word will accept.  Instructors could then show 

students a sample of letter and legal size paper. 
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Unit 3 – Introduction to Word Processing 

 

Suggestions for Assessment 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Resources 
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Unit 3 – Introduction to Word Processing 

 

Outcomes 
 

3.5.5 Change the page 

orientation of a document 

from portrait to landscape 

and vice versa. 

 

3.5.6 Use the right align, left 

align and center align buttons 

to change the alignment of 

text in a document. 

 

3.6 Create and modify bulleted 

and numbered lists in a document. 

 

3.6.1 Differentiate between 

bulleted and numbered lists. 

 

3.6.2 Produce a bulleted and 

numbered list in a document. 

 

3.6.3 Add bullets and 

numbers to an existing list in 

a document. 

 

3.7 Insert and format a picture in 

a document. 

 

3.7.1 Import a picture into a 

document. 

 

3.7.2 Apply Text Wrap to a 

picture in a document. 

 

3.7.3 Adjust the position 

and size of an inserted 

picture. 

 

 

 

 
 

Notes for Teaching and Learning 
 

 

 

 

 

 

 

 

 

 

 

Instructors should remind students that they can undo any 

action by clicking on the Undo button to go back one or 

more steps. 

 

Students can be instructed to use the horizontal ruler at the 

top of the text window to align lists.  Instructors can show 

students that clicking the ruler will create an indent tab, 

which provides a visual guide (vertical dotted line) to align 

numbered and bulleted lists.  If the ruler is not visible, 

students can click the View menu and select Ruler. 

 

 

 

If a student wants to insert a picture into their Word 

document from the Internet, they can be instructed to right-

click the image on the Web page and choose Copy.  Then 

they can Paste the image into their document.  Instructors 

can explain that the picture might contain a hyperlink that 

will launch the Internet browser.  The hyperlink can be 

removed by right-clicking the image in the document and 

choosing Remove Hyperlink.  Instructors should remind 

students to site the source of the image. 

 

Clip Art can be used by opening the Insert menu, then 

choosing Picture, and clicking Clip Art.  Students can then 

type a keyword to search the clip art library.  When they 

find an image they want, they can right-click, then select 

Insert.  Instructors should point out the sizing handles that 

can be used to adjust the size and placement of the clip art. 
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Unit 3 – Introduction to Word Processing 

 

Suggestions for Assessment 
 
 
 
 
 
 
 
 
 
 
 
Students could also complete “Enrichment Activity 4.3: 
Troubleshoot Bulleted and Numbered Lists” and place the 
edited document in their portfolio.  This activity is found 
under the Unit 4 Resources tab on the Glencoe Learning 
Center website. 
 
Students could also complete “Enrichment Activity 4.4: 
Manipulate Images” and place the edited document in their 
portfolio.  This activity is found under the Unit 4 Resources 
tab on the Glencoe Learning Center website. 
 
 
 
 
Students are required to complete the “Step-by-Step” 
exercise on page 163 and place a printed copy of the flyer 
in their portfolio. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Resources 
 
 
 
 
 
 
 
 
 
 
 
Glencoe Online Learning Center, 
http://glencoe.com 
 
 
 
 
Glencoe Online Learning Center, 
http://glencoe.com 
 
 
 
 
 
 
Computer Concepts in Action, 
page 163. 
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Unit 3 – Introduction to Word Processing 

 

Outcomes 
 

3.8 Format a document for 

printing. 

 

3.8.1 Select a printer that 

will handle a print job. 

 

3.8.2 Select the number of 

copies to be printed. 

 

3.8.3 Determine the print 

range to be printed. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notes for Teaching and Learning 
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Unit 3 – Introduction to Word Processing 

 

Suggestions for Assessment 
 
Students are required to complete the “Step-by-Step” 
exercise on pages 164 – 165 and submit the flyer to the 
instructor as an assignment. 
 
Answers to “Project 2 Assessment” questions on page 164 
of the text can be found in the Teacher Resource Manual. 
 
 

Instructors could use the ExamView Test Generator 

software along with the test bank of questions for this unit 

to create tests for students.  Instructors can customize the 

test to suit the needs of the class or add additional 

questions.  Instructors should review the test questions and 

choose the questions and formats that suit the level of the 

students. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Resources 
 
Computer Concepts in Action, 
pages 164 – 165. 
 
 
Computer Concepts in Action 
Teacher Resource Manual, Project 
1 Assessment Answers, page 195. 
 
CD-ROM: Glencoe Computer 
Concepts in Action, ExamView 
Pro Test Generator. 
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Unit 4 – Using the Internet 
 

Outcomes 
 

4.1 Discuss terminology relating 

to telecommunications, networks, 

and the Internet. 

 

4.1.1 Define Internet, World 

Wide Web (WWW), Web 

site, uniform resource locator 

(URL), and Internet service 

provider (ISP). 

 

4.1.2 Identify and describe 

common URL extensions. 

 

4.2 Identify the hardware and 

software required to connect to the 

Internet. 

 

4.2.1 Explain how a modem 

connects a computer to the 

Internet. 

 

4.2.2 Identify different types 

of Internet connections and 

the advantages and 

disadvantages of each 

connection type. 

 

4.2.3 Describe and give 

examples of a Web browser. 

 

4.3 Explain how electronic mail 

works on a network and on the 

Internet. 

 

4.3.1 Describe the benefits 

of using e-mail. 

 

4.3.2 Describe the different 

ways to write, send and 

receive e-mail. 

Notes for Teaching and Learning 
 

Instructors could facilitate a classroom discussion about 

how the Internet can be used.  Students should consider 

what they can accomplish online that would otherwise take 

more time, effort, or resources.  Examples could include 

doing research, shopping, making travel plans, and 

communicating with friends. 

 

Instructors should explain to students that the Internet is an 

online community where thoughts and ideas are exchanged 

freely.  Electronic mailing lists forward e-mail messages 

from individuals to everyone else on the list; online 

conferencing brings people in different locations together 

via voice or video; bulletin boards and newsgroups allow 

users to post information in a common area from which 

other members can read messages at their convenience; and 

chat rooms allow multiple users to engage in live, multi-

person messaging.  But while some communications are 

lead by a moderator who reviews messages for irrelevant or 

inappropriate content, many go unmonitored and can be 

dangerous. 

 

 

 

 

 

 

 

 

 

 

Instructors should explain to students that some 

communication, such as legal documents that require a 

signature, should be sent through traditional delivery 

methods rather than over the Internet.  There may also be 

security reasons for not sending documents over the 

Internet.  However, e-mail is a good way to maintain a 

record of communications, especially if a person needs to 

resolve any issues or keep records of communication about 

a specific topic for legal purposes. 
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Unit 4 – Using the Internet 

 

Suggestions for Assessment 
 

 

 

 

 

 

 

 

 

 

Students could complete questions 1 – 26 in the Unit 3 “e-

Quizzes–Pre-Quizzes” quiz found under the Unit 3 

Resources tab on the Glencoe Online Learning Center 

website.  This would help the student identify areas where 

he or she has some previous knowledge and areas that are 

not as familiar.   

 

Students can complete Worksheet 3A: “URLs: Name that 

Country” as review and reinforcement of Internet domain 

extensions.  Students can place the completed worksheet in 

their portfolio. 

 

 

Instructors could assign “Tech Talk Activity 2.4: Networks” 

as an optional assignment.  This activity is found under the 

Unit 2 Resources tab on the Glencoe Online Learning 

Center website. 

 

Instructors could assign “Tech Talk Activity 3.1: The 

Internet and the Phone Network” as an optional 

assignment.  This activity is found under the Unit 3 

Resources tab on the Glencoe Online Learning Center 

website. 

 

Instructors could assign “Tech Talk Activity 3.2: Viruses” 

as an optional assignment.  This activity is found under the 

Unit 3 Resources tab on the Glencoe Online Learning 

Center website. 

 

 

 

Resources 
 

Computer Concepts in Action, 

Unit 3 Using the Internet, pages 85 

– 124. 

 

Computer Concepts in Action 

Teacher Resource Manual, Unit 3 

Using the Internet, pages 147 – 

172. 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

 

 

Computer Concepts in Action 

Teacher Resource Manual, page 

360.  Also found on the Glencoe 

Online Learning Center, 

http://glencoe.com 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

 



 

______________________________________________________________________________ 

Curriculum Guide Page 37/44 Computer Technology 3101 

 

Unit 4 – Using the Internet 

 

Outcomes 
 

4.4 Discuss how e-mail can be 

used effectively. 

 

4.4.1 Define netiquette. 

 

4.4.2 Describe spam. 

 

4.5 Discuss how to stay safe 

while online. 

 

4.5.1 Assess the 

trustworthiness of a website. 

 

4.5.2 Describe ways to 

prevent identity theft while 

online. 

 

4.5.3 Evaluate the quality of 

information found on the 

Web. 

 

4.6 Demonstrate the ability to use 

a Web browsing application. 

 

4.6.1 Describe a Web 

browser. 

 

4.6.2 Define home page. 

 

4.6.3 Identify different 

elements of a Web site. 

 

4.6.4 Navigate the Web 

using a browser. 

 

4.6.5 Find specific 

information on a Web site. 

 

 
 

Notes for Teaching and Learning 
 

 

 

 

 

 

 

 

Instructors should reinforce to students that the Internet and 

World Wide Web are vast sources of information, services, 

and opportunity.  However, students should be aware of the 

challenges and potential dangers of using the Internet. 

 

If the school uses software to filter out inappropriate Web 

sites, instructors should explain to students how it works 

and explain what will happen if they try to access Web sites 

that are not permitted.  Instructors could discuss with 

students why schools and businesses use this type of 

software, and whether or not it is necessary. 

 

 

 

 

 

 

Instructors should explain to students that there is a home 

page for the Web browser and a home page for each 

individual Web site.  The Web browser’s home page (also 

called the start page) appears when the browser is launched.  

The start page can be accessed by clicking the Home icon 

in the toolbar.  Each Web site’s home page is the entry 

point for the site and it can be returned to by clicking a link 

on the Web site or the Back button on the toolbar. 

 

Instructors could demonstrate to students how to change the 

home page.  Suggestions for a home page could be the 

school’s Web site or a search engine such as Google.  

Under the Tools menu, click Internet Options, then click 

the General tab.  Under Home page, change the Address 

box to the desired home page URL.   
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Unit 4 – Using the Internet 

 
Suggestions for Assessment 
 

Instructors could assign “Tech Talk Activity 3.3: 

Netiquette” as an optional assignment.  This activity is 

found under the Unit 3 Resources tab on the Glencoe 

Online Learning Center website. 

 

 

 

Instructors could assign “Tech Talk Activity 1.2: Protect 

Yourself” as an optional assignment.  This activity is found 

under the Unit 1 Resources tab on the Glencoe Online 

Learning Center website. 

 

 

 

 

 

 

Answers to Tech Talk Captions and Activities are found in 

the Teacher Resource Manual. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resources 
 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

 

 

 

 

 

Computer Concepts in Action 

Teacher Resource Manual, pages 

154 – 156.   

 

Computer Concepts in Action, 

Unit 3 Project 1, pages 96 – 108. 

 

Computer Concepts in Action 

Teacher Resource Manual, Unit 3 

Project 1, pages 159 – 164. 
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Unit 4 – Using the Internet 

 

Outcomes 
 

 

 

 

 

 

 

 

4.6.6 Reload/Refresh the 

view of a Web page. 

 

4.6.7 Define bookmark. 

 

 

4.6.8 Show a history of 

recently visited Web sites and 

delete the list of recently 

visited Web sites. 

 

 

 

4.6.9 Manage bookmarked 

sites/favorite sites. 

 

 

 

 

 

 

 

4.6.10 Print all or specified 

parts of a Web site. 

 

 

 

 

 

 

 

 
 

Notes for Teaching and Learning 
 

Before students start any activity that uses Web sites, 

instructors should check that the suggested URLs are 

accessible from the school’s network.  If not, students may 

become frustrated or confused by the “Page Not Found” 

message.  Instructors should be prepared to provide a new 

URL as a substitute for the ones in the textbook. 

 

Instructors should explain to students that a high number of 

users and lower computer speeds can cause Web pages to 

download slowly.  Instructors should remind students that 

double-clicking or triple-clicking a link will not cause the 

computer to respond any faster. 

 

When a computer is shared by several users, its History 

folder fills up with pages that may not have been visited by 

a particular student.  To clear the sites and pages from the 

History folder, click the Tools menu and then Internet 

Options.  In the Internet Options box, click on the General 

tab and the click the Clear History button. 

 

If the computers at the school are frozen, the History and 

Favorites will reset every time the computer is started.  

Students could save Favorites to their class or personal 

folder.  To save favorites, choose the File menu and choose 

Import and Export.  Follow the instructions in the 

Import/Export Wizard to export Favorites to a chosen 

location.  The Wizard can be used to import them again to 

see the saved Favorites. 

 

Web pages that use frames (separate windows within a 

page) may cause printing problems.  The Print Preview 

dialog box contains buttons for pages with frames.  If the 

desired text does not appear in the Preview window, close 

the Preview window, click on the desired text on the Web 

page, and go to the Print Preview again.  This will bring up 

the required frame. 
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Unit 4 – Using the Internet 

 

Suggestions for Assessment 
 

Students can complete Worksheet 3B: “Evaluate a Web 

Site” as review and reinforcement of Web browsing.  

Students can place the completed worksheet in their 

portfolio. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Instructors could have students complete the “Internet 
Terminology” Enrichment Activity outlined in the Teacher 
Resource Manual as an optional assignment. 
 
Students are required to complete the “Step-by-Step” 
exercise on pages 104 – 105 and place a printed copy of the 
website in their portfolio. 
 
Answers to “Project 1 Assessment” questions on page 106 
of the text can be found in the Teacher Resource Manual. 
 
 
Students are required to complete the “Step-by-Step” 
exercise on pages 106 – 107 and submit the printed website 
to the instructor as an assignment. 
 
 

Resources 
 

Computer Concepts in Action 

Teacher Resource Manual, page 

361.  Also found on the Glencoe 

Online Learning Center, 

http://glencoe.com 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Computer Concepts in Action 
Teacher Resource Manual, page 
164. 
 

Computer Concepts in Action, 

Step-by-Step, pages 104 – 105. 

 
 
Computer Concepts in Action 
Teacher Resource Manual, Project 
1 Assessment Answers, page 162. 
 
Computer Concepts in Action, 
Step-by-Step, pages 106 – 107. 
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Unit 4 – Using the Internet 

 

Outcomes 
 

4.7 Demonstrate the ability to 

effectively search the Internet for 

information. 

 

4.7.1 Define search engine. 

 

4.7.2 Explain how a search 

engine classifies and looks 

for Web sites. 

 

4.7.3 Use a search engine to 

search for information based 

on specified keywords. 

 

 

 

 

 

 

 

 

 

4.7.4 Define Boolean 

search. 

 

4.7.5 Provide examples of 

Boolean symbols and their 

meanings. 

 

4.7.6 Use a Boolean search 

to search for specific 

information on the Internet. 

 

 

 

 

 

 

 
 

Notes for Teaching and Learning 
 

Knowing how to find information about a subject is an 

essential skill.  Many employees prefer to hire those who 

are resourceful about tracking down the information they 

need. 

 

Even with the best filters and screening techniques, 

students can either intentionally or inadvertently wind up 

following links to inappropriate Web pages.  Instructors 

should remind students of the Acceptable Use Policy and 

the consequences for visiting inappropriate Web sites. 

 

Students may be surprised at some of the search results that 

supposedly match the keyword they entered.  Instructors 

could discuss ways students can recognize useful and 

accurate Web sites.  For example, they can look at the 

descriptive summary in the results list and determine if it 

covers the subject they want, or the can look at the URL 

and see if it is from a reliable organization.  Instructors 

should tell students to expect to find that some Web sites 

have been discontinued, as sites sponsored by individuals 

disappear quickly. 

 

Boolean expressions can sometimes produce unexpected 

results.  For example, “cats AND Persian or Siamese” will 

find matches for Persian cats or anything to do with 

Siamese, whether the name refers to cats or not.  Similar to 

precedence in a mathematics equation, keywords on either 

side of the AND are evaluated first.  Thus, pages with “cats 

and Persian” display before pages with “Siamese”.  To 

limit the search to cats, use the parenthesis as follows: “cats 

AND (Persian or Siamese).  

 

If students are allowed to save Favorites, instructors could 

have them organize the relevant Web sites they find so they 

can easily come back to them later.  Each student can open 

his or her Favorites list, create a new folder, and name it.  

They can move their bookmarked sites into the folder to 

use in the next exercises. 
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Unit 4 – Using the Internet 

 

Suggestions for Assessment 
 

 

 

 

 

 

 

 

Students can complete Worksheet 3C: “Internet Concepts” 

as review and reinforcement of Internet terminology.  

Students can place the completed worksheet in their 

portfolio. 

 

 

Students could complete “Enrichment Activity 3.1: Copy 

Elements of a Website” and place a copy of the document 

in their electronic portfolio.  This activity is found under 

the Unit 3 Resources tab on the Glencoe Learning Center 

website. 

 

Students could complete “Enrichment Activity 3.2: 

Download a file from a website” and place a copy of the 

document in their electronic portfolio.  This activity is 

found under the Unit 3 Resources tab on the Glencoe 

Learning Center website. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resources 
 

Computer Concepts in Action, 

Unit 3 Project 2, pages 109 – 121. 

 

Computer Concepts in Action 

Teacher Resource Manual, Unit 3 

Project 2, pages 165 – 172. 

 

Computer Concepts in Action 

Teacher Resource Manual, page 

362.  Also found on the Glencoe 

Online Learning Center, http:// 

glencoe.com 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 
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Unit 4 – Using the Internet 
 

Outcomes 
 

 

 

 

 

 

 

 

4.7.7 Use a Web site’s table 

of contents and search feature 

to find information. 

 

 

4.7.8 Save the content of a 

Web site for offline 

browsing. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notes for Teaching and Learning 
 

Before assigning any practice exercise, instructors should 

preview all sites to ensure they are appropriate for students 

and determine if the Web pages have changed since the 

figures in the exercise were created.  Students should be 

prepared for any differences between what they see in the 

textbook and what they may see on their screens. 

 

If a browser other than Microsoft Internet Explorer is used, 

students should be aware of possible screen displays and 

instructions.  If necessary, instructors should outline the 

differences between Internet Explorer and the browser. 

 

When students reopen their saved Web page, it will appear 

in the program assigned to open HTML documents – not 

necessarily Internet Explorer.  To open the page in Internet 

Explorer, first open Windows Explorer, then click the 

Tools menu, click Folder Options, and click the File Types 

tab.  All registered file extensions and the programs used to 

open them will be displayed.  Click the HTM and HTML 

extensions and change the program they open with to 

Internet Explorer. 

 

Students may assume that saving a Web page is 

unnecessary if they save the link as a Favorite.  There is a 

big difference between a saved page and a link to the page.  

The link is dynamic – that is, if the content of the page is 

changed, the user will see the new content.  A saved page is 

static – years from now, the page will look the same.  

Saving a page is a good idea for sites that change 

frequently, such as e-zines and newspapers. 
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Unit 4 – Using the Internet 

 

Suggestions for Assessment 
 

 

 

 

 

 

 

 

 

 

 

Students are required to complete the “Step-by-Step” 

exercise on pages 117 – 118 and save a copy of the website 

in their electronic portfolio. 

 

Answers to “Project 2 Assessment” questions on page 119 

of the text can be found in the Teacher Resource Manual. 

 

 

Students are required to complete the “Step-by-Step” 

exercise on pages 119 – 120 and submit their results to the 

instructor as an assignment. 

 

Students could complete questions 1 – 25 in the Unit 3 “e-

Review quiz” found under the Unit 3 Resources tab on the 

Glencoe Online Learning center to test their comprehension 

of the outcomes covered to this point. 

 

Instructors could use the ExamView Test Generator 

software along with the test bank of questions for this unit 

to create tests for students.  Instructors can customize the 

test to suit the needs of the class or add additional 

questions.  Instructors should review the test questions and 

choose the questions and formats that suit the level of the 

students. 

 

 

 

 

 

Resources 
 

 

 

 

 

 

 

 

 

 

 

Computer Concepts in Action, 

Step-by-Step, pages 117 – 118. 

 

 

Computer Concepts in Action 

Teacher Resource Manual, Project 

2 Assessment Answers, page 168. 

 

Computer Concepts in Action, 

Step-by-Step, pages 119 – 120. 

 

 

Glencoe Online Learning Center, 

http://glencoe.com 

 

 

 

CD-ROM: Glencoe Computer 

Concepts in Action, ExamView 

Pro Test Generator. 

 


